# Table of Contents

Chapter 1: Introduction ........................................................................................................ 4  
  Welcome to Office 2010 ...................................................................................................... 4  
  Tips - Incoming! .................................................................................................................. 5  
  Backward Compatibility .................................................................................................... 5  
Chapter 2: Exploring Backstage .......................................................................................... 6  
  Customizing the Ribbon ..................................................................................................... 6  
  Collaborate Backstage ....................................................................................................... 8  
  Fix Those Annoying File Blocks ...................................................................................... 8  
Chapter 3: Word! .................................................................................................................. 10  
  Making Repetitive Tasks Quicker ..................................................................................... 10  
  Learning to Use Building Blocks - Continued ................................................................. 11  
  Enjoying Word’s Improved Document Search .................................................................. 13  
  .Doc and .Docx Compatibility ......................................................................................... 13  
Chapter 4: Excel .................................................................................................................. 15  
  Present Data at a Glance with Sparklines ........................................................................ 15  
  Groups Save Time ............................................................................................................ 16  
Chapter 5: Power Up Powerpoint ....................................................................................... 18  
  The New Transitions Tab .................................................................................................. 18  
  Quick Application and Replication of Animations .......................................................... 19  
  Go Beyond Animation with Video ................................................................................... 21  
  Live Broadcasting ............................................................................................................ 22  
Chapter 6: Looking Out for Outlook ................................................................................... 24  
  Social Gatherings ............................................................................................................. 24  
  Follow Conversations ....................................................................................................... 25  
  Find Emails Easily with Search ...................................................................................... 26  
Chapter 7: Conclusion ......................................................................................................... 27
Chapter 1: Introduction

Welcome to Office 2010

There are few names in PC software more iconic than Office. The word itself is generic, but the popularity of Microsoft’s productivity suite has made it instantly recognizable in the context of computers. It reaches beyond the boundaries of geekdom and into the lexicon of everyday cubicle warriors, who use the software constantly for everything from email composition to corporate presentations.

Microsoft’s last version of Office, Office 2007, was a big deal. It was nearly as large an overhaul as Windows Vista was compared to Windows XP. While Office 2007 has many detractors – any major change to a popular and entrenched program is bound to result in some agony – the revision was mostly successful. Microsoft rolled out a major new user interface, known as Ribbon, without excessive growing pains.

Office 2010 is, by comparison, a minor update. That’s not to say it doesn’t include new features, some of which are incredibly useful, but the interface is largely the same. Users of Office prior to Office 2007 had a bit of a learning curve associated with becoming re-acquainted with the software, but anyone comfortable with Office 2007 should have no problem with 2010.
Tips - Incoming!

Since Office 2010 doesn’t change as much as Office 2007, there isn’t as much to instruct users on how to use the new software. Users who are coming from 2003 will still have to become acquainted with the Ribbon interface, but frankly, most general tips related to the 2007 version will still help you there (but specifics, of course, have changed).

Instead, Office 2010 has many improvements. This guide will focus on teaching users coming to Office 2010 how to take the most from the program and use every feature offered. In most programs, it’s not hard to find every single feature, but Office 2010 is so expansive that even veteran users will often find that they aren’t expert in even half of the capabilities the software offers.

The tips you find here should be of use to most people who use Office 2010 regularly. My goal was not to go for obscure hacks, but rather to present useful information that isn’t commonly known. Hopefully this will make you more productive, or at least give you the tools needed to handle your work with more speed and less stress.

Backward Compatibility

The tips that I’m presenting in this guide are purely from the perspective of Office 2010. That is not to say some of them won’t be partially or fully applicable to Office 2007, but a lot of the tips focus on new features that were added in Office 2010.

Mac fans who are using Microsoft Office for Mac 2008 – which likely includes most people reading this on an Apple computer - will find very little information in this guide useful. Microsoft Office for Mac 2008 didn’t even use the ribbon interface, so there are many differences. You’re more likely to find similar features in the recently released Microsoft Office for Mac 2011; however, keyboard shortcuts and menu layouts may be different in many situations.
Chapter 2: Exploring Backstage

The largest change to the Office 2010 interface is the introduction of the Backstage. Gone is the File menu, and gone also is the Office button from Office 2007. Now you’ll find a File tab. But when you click on it, you’ll no longer open a menu, but instead open an entirely new portion of the interface.

Despite the new interface element, most of the tasks accomplished in Backstage are completely mundane. You can open, save, and print files, explore recent documents, and open new documents. Yawn!

There are, however, some interesting features to be found if you dig deeper into Backstage. You just need to go looking for them.

Customizing the Ribbon

The Microsoft Office ribbon isn’t going anywhere – at least, not until Microsoft decides to revamp Office again, which likely won’t happen until the end of this decade.

Don’t take this to mean that what you’re presented with the first time you open Microsoft Office is set in stone. It is possible to trick out the interface of Office 2010 in a number of ways, although the method of doing so isn’t obvious while you are using the software. Changing the interface requires that you go Backstage and open the Options menu, then navigate down to Customize Ribbon.
The ribbon interface is, by default, fairly busy. However, it actually does not represent the vast majority of potential commands that are available in any particular piece of Office software. The entire point of the Ribbon interface was to reduce clutter, and this meant getting rid of deep menu trees and getting rid of command buttons for functions that were rarely used.

Of course, rarely used is not the same as never used. Those commands are still there, and you can find them in the Commands, not in the Ribbon section.

Let’s say, for example, that I wanted to have quick access to the Borders and Shading menu, and I want to add this button in the Insert tab. I can’t add commands to any of the default groups, so to do this I have to highlight the Insert tab and then click New Group. Once I’ve created a custom group, I can then highlight that group and bring over the Borders and Shading command. Presto! Now, Borders and Shading appears in my Insert tab.

That’s just the beginning. You can also create new tabs, so if you’d like you could create an entire tab full of custom groups with custom commands. Although I’m not enough of an interface junkie to want to do this, the tools are available to you if that’s what you’d like to do.
Collaborate Backstage

The Save command found in previous versions of Office has now been replaced with a Backstage section called Save and Send. You can use this to save your documents, of course. But this is also where Office’s many collaboration features come into play.

There are a few ways to share documents (besides email, obviously). The Save to Web option will save your documents to your Windows Live Skydrive account. This is a free account that can be used to store documents and share them with others. Skydrive uses a web interface and can be accessed at skydrive.live.com.

From Skydrive you can share documents with your friends, family and co-workers by either sending a link or adding them to the file permissions (via their email address). If you give permission, others can edit these documents, creating a truly collaborative Microsoft Office document without the need for a Sharepoint server – although Sharepoint is still part of the Office ecosystem and can, in fact, be accessed directly below Save to Web.

Fix Those Annoying File Blocks

It’s sad, but true: security improvements go hand-and-hand with annoyance. Adding more hurdles for malware unfortunately results in more hurdles for users. I’d be perfectly happy with not running a firewall and antivirus if malware did not exist. But it does, so I have to deal with adding those extra pieces of software to my system.

Office 2010 has its own security improvements and its own corresponding annoyances, the greatest of which has to deal with file trust. Many older file types from Microsoft have been dissected by hackers over the years, and security flaws have been found. Malware such as macro viruses, which hide in Excel spreadsheet macros, piggy-back seemingly legitimate Office documents as a means of spreading.
By default Office 2010 blocks certain types of documents. They will open, but only in Protected View, which means they can’t be edited. To change this behavior you can open Options in the Backstage area, then go to Trust Center, and then open Trust Center Options. Finally, open File Block settings. You’ll find a number of file types and checkboxes that can be selected to enable or disable handling those files in Protected View.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Open</th>
<th>Save</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word 2007 and later Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenDocument Text Files</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 2007 and later Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 2003 Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 2003 and Plain MHT Documents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word XP Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 2000 Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 97 Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 95 Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 6.0 Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word 2 and earlier Binary Documents and Templates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Pages</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RTF Files</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Text Files</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legacy Connectors for Word</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Office Open XML Converters for Word</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

While you’re there, you might also want to check out the Protected View menu, which determines how Protected View handles files from certain origins, such as those downloaded from the Internet. Just keep in mind that while disabling Protected View might be more convenient, it could open you up to certain malware threats. Microsoft didn’t put the feature into Office because its programmers had too much time on their hands!
Microsoft Word is undoubtedly among the most used pieces of software on the planet. It’s the go-to word processor for businesses, schools, governments and most home users. You wouldn’t think that a word processor could be complex, but there are actually a lot of ways to manipulate a document, and Word has grown over the years from a fairly simple tool into a comprehensive program that can be used to create nifty materials like the .PDF guide you’re reading right now.

I thought that I knew everything there was to know about Word when I began composing this guide, but as it turns out I was wrong. I mostly use Word for writing, but there’s more to the software than that.

### Making Repetitive Tasks Quicker

Word documents aren’t always unique – in fact, I’d bet that most of the content created with Word is in some way a repetition of content that’s already been created before. That may sound odd, but think about it. Businesses use Word constantly, and businesses put out a lot of documentation with repetitive information like the business’s address, the names of employees, and so on.

If you’re in a situation like this you can make life easier by creating a Quick Part. Select whatever text or content you plan on frequently using and then go to the Insert tab. Find the Quick Parts button and click on it to call a drop-down menu.

Now, click on Save Selection to Quick Part Gallery. A window will open prompting you to enter the name of the quick part. You might want to create a new category for it if you intend to have many different quick-parts, but you shouldn’t have much reason to change the Save In and Options categories.
Now that you’ve made a Quick Part, you can enter it by clicking the Quick Parts button and then selecting it from the drop-down menu. Doing this for common information, such as a business address, can save a lot of time and effort.

Learning to Use Building Blocks - Continued

The Quick Part you created is part of a larger category of Microsoft Word tools known as Building Blocks. A Building Block is any type of saved content that is not a document, but rather a portion of a document - and it’s not saved on its own, but in the Word interface. Once saved, you can call upon that Building Block again. In this way you can use very complex design elements in numerous documents without spending ages trying to correctly format them.

We’ve already talked about how to make a Quick Part, which is one type of Building Block, but it’s not the only type. You can apply Building Blocks to Headers and Footers, after which they can be selected and automatically added to one or all of the pages of a document.

For example, let’s say I want to create a header for my business. I type the following.

Acme Services | 555-123-4567 | 811 Strump Street, New York, NY
All Your Toggelumping Needs – In One Convenient Location!

To all of you document ninjas out there - I didn’t say it was a GOOD header. It’s just a header for example purposes, of course!

As the chief of advertising for Acme Services, I want to save this header so that I can use it in the future. That’s no problem. I just select, click on the Header button in the Insert tab to call the drop-down menu, and then click Save Selection to Header Gallery. Just as with the Quick Part made in the earlier example, my custom header now appears whenever I click on the Header button.
If you think that the process for creating a custom footer is the same, pat yourself on the back. It most certainly is! There are also two other buttons on the Insert tab that provide the same functionality; the Equation button and the Cover Page button.

Of course, as you become familiar with Building Blocks and begin to use them more frequently you may end up needing to rearrange, delete, or change some of the Building Blocks you have available. You can access the Building Blocks Organizer by clicking on Quick Parts and then clicking the Building Blocks Organizer menu selection. Or, if you’d like, you can use the instructions in the Chapter 2 section “Customizing the Ribbon” to add the Building Blocks Organizer as a button to your Insert tab.

The organizer itself is extremely basic, so I’ll explain it quickly. The organizer window consists of a list of Building Blocks on the left and a preview pane on the right. The Edit Properties button will bring up the menu that you used to add the Building Block so you can change the category and so on. As you might expect, the Insert button places the Building Block in your document and the Delete button makes the Building Block vanish from your sight!
Enjoying Word’s Improved Document Search

Document search has always been part of Office, but it’s not always been easy to use. It used to be its own menu that opened up and requested that you typed what you were looking for. Then you’d basically go through the document, one instance of the word or phrase at a time. It worked, but it was slow and confusing.

Microsoft has smartened up with Office 2010 and modeled the search function to be more like an online search engine. That means context. When you open search (the shortcut is still Ctrl-F) a sidebar expands on the left side of the screen, and you can type in what you’re looking for. However, you are now provided with a short text excerpt from your document, which provides context for what you’re trying to find. When you’ve located what you were looking for you can click on the corresponding preview in the sidebar to be taken directly there.

This new search feature is much quicker than what was offered before, but you can still access the older menu by clicking on the arrow beside the search magnifying glass. This will present a drop-down menu that includes Advanced Find and Find and Replace, both of which open a menu similar to the older search function. You can also navigate directly to a specific page or other document element by using the Go To function. Finally, you can search for graphics, tables, and equations by selecting these options from the drop-down menu.

.Doc and .Docx Compatibility

Before moving on to Excel, I wanted to add a brief note about the difference between .doc, Microsoft’s older document format, and .docx, the new format. Microsoft switched to .docx in Office 2007, but the change was significant and still
causes users some confusion when they’re coming from older versions of Microsoft Office.

The new .docx format is now the standard for Microsoft Word. All versions of Microsoft Word after Office 2007 will be using this format. However, all earlier variants of Microsoft Word are unable to open .docx.

You can fix this by downloading an Office compatibility pack. However, you will lose some of the features available in Office 2007 in above. For example, Bibliography and Citation text is converted to standard, static text. A full list of the features lost when opening a .docx file in an older version of Word is available from Microsoft.
Chapter 4: Excel

Excel has been a favourite tool of organizers and number-crunchers for over two decades. Microsoft has gradually added new functions over time, but hasn’t rested or failed to keep up with competitors. Microsoft Excel is still the premier; indeed, there are few competitors that are remotely as capable.

Present Data at a Glance with Sparklines

One of the cool new features added in Excel 2010 is Sparklines. If you’re like me, and you don’t pay attention to the names of graphs and other such information, you may not have heard of Sparklines – but you’ve probably come across them in a newspaper or on a website.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Year</td>
<td>Widget Sales (In Millions)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Apr</td>
<td>May</td>
<td>Jun</td>
<td>Jul</td>
<td>Aug</td>
<td>Sept</td>
<td>Oct</td>
<td>Nov</td>
<td>Dec</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2008</td>
<td>2.1</td>
<td>2.4</td>
<td>2.6</td>
<td>2.8</td>
<td>3.5</td>
<td>3.9</td>
<td>4.1</td>
<td>4.2</td>
<td>3.5</td>
<td>4.2</td>
<td>5.0</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2009</td>
<td>3.5</td>
<td>3.9</td>
<td>3.8</td>
<td>3.1</td>
<td>3.6</td>
<td>4.2</td>
<td>4.5</td>
<td>4.1</td>
<td>3.9</td>
<td>3.8</td>
<td>4.5</td>
<td>5.2</td>
</tr>
<tr>
<td>5</td>
<td>2010</td>
<td>3.1</td>
<td>3.6</td>
<td>3.9</td>
<td>4.3</td>
<td>4.5</td>
<td>4.1</td>
<td>4.2</td>
<td>3.9</td>
<td>4.5</td>
<td>5.1</td>
<td>5.6</td>
<td>6.0</td>
</tr>
</tbody>
</table>

A Sparkline is a small, high density graph that is meant to present a condensed form of information. Unlike a full graph, that usually has a visible X and Y axis, Sparklines are alone. They don’t provide as much detail as a normal graph, but because there’s no X and Y axis or other luggage, you can fit Sparklines into small spaces – like a cell on a Microsoft Excel spreadsheet - easily. Sparklines are quicker and smaller than a full graph and often just as useful.
There are three different types of Sparklines; line, column and win/loss. The first two are likely to be familiar to anyone who has used charts even a few times before. The line chart makes a graph of each data point and then draws lines between them, of course, and the column chart make each data point an appropriately sized column. The win/loss option is a bit different, however; it presents information as a binary “up” or “down” box.

Sparklines are simple to insert. You only need to click the appropriate Sparklines button in the insert tab and then select the data you want to graph. Everything else is handled for you automatically. You can click on the Sparkline and select the Sparkline Tools tab to make some adjustments. For example, line graphs are smooth by default, but you can click the Markers checkbox to add a square box to represent each data point. You can also edit the colours of the graph. One popular example is the use of a green colour to highlight the most positive data on a graph and a red colour to indicate the most negative.

Groups Save Time

Excel spreadsheets usually start small, but they can turn into real monsters. Making a personal budget seems simple enough; but if you end up itemizing everything you buy, reconciling all of your books precisely, and making charts to visualize the rate that you’re paying off debt, the whole thing can become surprisingly complex. And that’s just one person. Organizations can end up with spreadsheets with tens or hundreds of pages.
Managing a sprawling spreadsheet is difficult, but one way of saving some time is by grouping sheets. The grouping lets you automatically reproduce formatting on one page of a spreadsheet on all other pages. For example, let’s say that I want to run a monthly budget over the course of a year. I could make a spreadsheet with twelve pages, and then group them to reproduce the formatting. I’d only have to format one page to format every month for the entire year.

There are two ways edit pages as a group. If you want to edit every page you have open, you can right-click on any Sheet tab and then click Select All Pages. All of the page tabs should be highlighted in white to indicate they’re being edited together. Alternatively, you can pick out select sheets by clicking on them while having the Ctrl keyboard button pressed. In either case, you should see the [Group] text now appear in the sheet’s name on the title bar.
Chapter 5: Power Up Powerpoint

Microsoft Powerpoint is both a blessing and a curse for office workers everywhere. On the one hand, it’s a great way to create presentations that can be used alongside a speech or in a meeting. On the other hand, it’s the prime weapon of office cheesiness, partially thanks to the overuse of pixelated, generic clipart.

The folks at Redmond aren’t completely drunk on their own kool-aid, however, and they’ve been working hard to make Powerpoint a more modern and slicker presentation tool. That’s why most of this chapter focuses on features of Powerpoint 2010 like videos and animations. Want to lose the cheese? Start reading!

The New Transitions Tab

Powerpoint animations used to be fairly terrible, but they’re becoming more sophisticated. They’re such an important part of Powerpoint 2010, in fact, that there are now two tabs that are entirely devoted to animations. The first one we’re going to talk is transitions. In Office 2007 these functions were placed together into the animations tab, but now that they’re separate there is more detail provided for each function.

Transitions in Powerpoint work the same as they do in a video editor like iMovie or Windows Live Movie Maker. When you open the tab you’ll find a gallery of transitions with a wide variety of options. You can also adjust the duration of the transitions; the sounds (if any) used alongside the transition, and apply the transitions to all slides at once. Transitions are selected simply by clicking on them. You don’t have to click OK, or set them up, or anything – click once, and you’re done.

http://smidgenpc.com | Matt Smith
MakeUseOf.com
Quick Application and Replication of Animations

The Animations tab is a bit deeper in Office 2010, and while this tab did exist in Office 2007, it’s actually the tab with the most new content. Now that transitions have their own tab, separate from animations, there are lots of new things included. For example, animations like Motion Paths are now held in a gallery, and they’re much easier to use than before.

That said, the best new features related to animations are also among the least obvious, and aren’t new ways to add animations but rather new ways to manipulate them and easily replicate them. Take Animation Painter as one example. This tool, located to the right of the animation tab gallery, lets you quickly copy an animation to multiple objects. First, you click on an object that has been given an animation. Then, click Animation Painter. The next object you click in your Powerpoint will be given the same animation. You can then click Animation Painter again and do this for another object, and so on. In this fashion, you can easily apply an animation to multiple objects.
The Animation Pane is also incredibly useful. Found above the Animation Painter option, the Animation Pane lets you change how animations play in your presentation. When you click on a slide with animations, the animations will appear in the order they’ll display. You can re-arrange them via drag-and-drop. But they don’t have to play in order at all; if you right click an animation in the Animation Pane, you’ll have the option of playing the animation alongside the animation that comes before or after. Precise adjustments to timing can be made by dragging the rectangles that are found besides the text of each animation – this changes when the animation begins to play and how quickly it plays.
Go Beyond Animation with Video

Okay, animations are fine and dandy. You can use them to add some extra flair to a document, or for more practical purposes, such as keeping certain information off-screen until you want it, at which point you swing it in with a nice animation. However, animations are limited; you have to use what Powerpoint gives you, or get REALLY creative with still images. Wouldn’t it be easier to just add video?

The answer used to be “well, not really” due to Powerpoint’s shoddy implementation of video objects. 2010 has changed things, however. You now can easily embed videos from both local and online files, and you have access to a wide variety of editing options.

First things first – you’ll find the Video button on the far right of the Insert tab. You can click on it to go directly to adding a local file, or you can click the arrow beneath for additional options, such as adding a file from a website.

Once you have added a video it will appear in the slide with a little player alongside the button, with which you can pause or play the video. By default, you will need to click in order to start the video when the slide appears, but remember the Animation Pane? Well, it’s back, and can be used to edit the timing of videos so that they play at the beginning of a slide or alongside other objects.
You’ll find more options if you right-click on a video and then click Trim Video. This will open a small editing menu that allows you to adjust the length of the video and clip off parts that aren’t needed. You can also modify the video using the Format Video option. This lets you adjust brightness, crop the video, and make other modifications.

**Live Broadcasting**

So Powerpoint 2010 no longer handles videos as though it were made in 1999. That’s great, but perhaps you’re just left thinking “well, it’s about time.” If so, don’t worry. They’ve gone one step further and added an awesome feature that’s quite modern; broadcasting. This feature lets you show your Powerpoint to others across the Internet.
To access this new feature click on the Slide Show tab, then click the Broadcast Slide Show option. A window for the PowerPoint Broadcast Service will open. To use it, you need a Windows Live ID – like some other features, such as the SkyDrive file sharing we talked about in chapter 2. After you enter your Windows Live ID you will be given a link. Anyone who has the link can view the slideshow.

Surprisingly simple, isn’t it? You can even put the link in your own browser if you’d like a demonstration.
Chapter 6: Looking Out for Outlook

Although Microsoft updated Windows 2007 extensively, one area that notably didn’t receive the bulk of the updates – such as the Ribbon interface – was Microsoft Outlook. Unlike its brethren, Outlook retained the old-fashioned menu-tree design. Although not everyone was unhappy with that, it did leave the program feeling like an odd man out.

Office 2010 solves that problem and updates it to bring it in line with the rest of the Office suite. You will now be using the Ribbon interface just as you would in any other Office program. That’s far from the end of Outlook’s revision – there is a host of new features that are worth exploring.

Social Gatherings

Microsoft is often seen as a stodgy, old-fashioned company, which is probably why Microsoft tries very hard to add social networking features to most new products. Outlook is no different, and the 2010 revision contains a feature called Social Connector. The job of Social Connector is to import social network contacts into Outlook so that you have that information available when you send emails.

Office 2010 supports four different social networks - Facebook, LinkedIn, MySpace and Windows Live Messenger. The connectivity isn’t installed by default, so you have to go to the Microsoft Office website and download the software. Fortunately the installer is no more than 12 megabytes, so it’s a quick download.

Once you run the Social Connector Provider for your favorite social network, go to the People Pane in the View Tab, then click on Account Settings. A window will pop up showing all of the connectors you have downloaded and installed; if you did not visit the website above and install the software, you’ll only see the My Site option. Clicking on the checkbox next to a particular social network will bring up a login screen.
After you’ve done this, information about a contact will appear below the reading pane. This may be minimized by default, so click on an email to open it for reading and then find the small contact listing, separated by a movable white bar, at the bottom.

This feature pulls information about anyone. Of course, if you’re talking to them regularly in email you may want to add them as a friend, which you can do by clicking on the little green plus symbol.

**Follow Conversations**

The idea of the email “conversation” is probably one of the most significant advancements to email in the last five years; Gmail users don’t know how to function without it. It only makes sense that emails that are part of the same chain of responses should be lumped together so they’re all easily viewable at once, but for most of email’s life that’s not how it worked.

Office 2007 was notably lacking this feature, and since Office is mainly updated in big leaps rather than small patches, Outlook users had to wait until Office 2010 for it. But now you have it, and while the feature may be late, it makes up for that by being a particularly good rendition of the idea.

The conversation feature actually is not turned on by default, but can easily be activated by going to the View tab and clicking the checkbox next to Show as Conversations.

After enabling conversations, you have a few choices you can make, which are enabled using the Conversation Settings button. The only option selected by default
is Show Messages From Other Folders, which simply lets conversations span multiple folders. The other choices are as follows.

- Show Senders Above the Subject: Simply flips the sender and subject lines so that the subject is now on the bottom.
- Always Expand Conversations: Automatically converts a conversation into expanded view, which shows all people involved in the conversation, when you click on it.
- Use Classic Indented View: Turns off the funky conversation graphs that are supposed to show you how different people and messages relate to each other, but sometimes fails to be clear.

Find Emails Easily with Search

In chapter 3 I touched on the Word navigation pane, which replaced the old Find window. Word isn’t the only Office 2010 program that has received an updated search feature, however; Outlook also has one, and it’s even more detailed.

You can begin searching by typing into the inconspicuous text box located over your email previews. As you’d expect, typing in a word or phrase will narrow down the list of results to those that include what you’re looking for. The real magic is found in Tab that now appears in the Ribbon interface.

Using the Search tab you can drastically narrow down your search. It’s possible to search only emails from a specific contact, only the subject line, only emails with attachments, only emails sent within a certain time frame, only emails that are unread, only emails that are categorized, and more. You can also open recent searches.
The tips and tricks found in this guide were picked to help you increase your productivity with Office 2010. I wanted to brush aside the technical mumbo-jumbo, forget about features that aren’t exciting, and go straight to what’s truly cool and what can truly save you time. Learning about an Office suite isn’t everyone’s idea of a good time, but if you use Office as frequently as I do, learning how to customize the interface or make cool graphs is awesome – in an admittedly nerdy way.

Still, even this guide can’t contain every single Office tip or trick. MakeUseOf’s team of writers is always looking for cool things to do with software, and we have a fair amount of articles covering different aspects of Office 2010 and its suite of programs. I’ve listed some of the most interesting articles below.

- 5 PowerPoint Search Engines To Seek Out Publically Available Presentations
- 15 Useful Excel Templates for Project Management and Tracking
- Boost Your Microsoft Office Skills With Ribbon Hero
- How To Add Live Web Pages To A Microsoft PowerPoint Slide
- How To Build a Mind Map in Microsoft Word
- How To Create A Website Header Image Using PowerPoint
- How To Collaborate With Track Changes In Microsoft Word

http://smidgenpc.com | Matt Smith
MakeUseOf.com
• How To Harmoniously Work With Google Docs from Microsoft Outlook
• How To Use Drop Caps To Enhance Your Text In Microsoft Word
• A Microsoft Office 2010 Review – Better Than Office 2007?
• The Top Five Sites To Download Microsoft Word Templates
• Use Microsoft Office for Free with Microsoft Web Apps
Did you like this PDF Guide? Then why not visit MakeUseOf.com for daily posts on cool websites, free software and internet tips.

If you want more great guides like this, why not subscribe to MakeUseOf and receive instant access to 20+ PDF Guides like this one covering wide range of topics. Moreover, you will be able to download free Cheat Sheets, Free Giveaways and other cool things.

Subscribe to MakeUseOf: http://www.makeuseof.com/join

MakeUseOf Links:

Home: http://www.makeuseof.com
MakeUseOf Directory: http://www.makeuseof.com/dir
MakeUseOf Answers: http://www.makeuseof.com/answers
Geeky Fun: http://www.makeuseof.com/tech-fun
PDF Guides: http://www.makeuseof.com/pages/
Tech Deals: http://www.makeuseof.com/pages/hot-tech-deals

Follow MakeUseOf:

RSS Feed: http://feedproxy.google.com/Makeuseof
Newsletter: http://www.makeuseof.com/join
Facebook: http://www.facebook.com/makeuseof
Twitter: http://www.twitter.com/Makeuseof